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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (www.hp.com/
managementsoftware/svi_partner_list), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at:

www.hp.com/managementsoftware/services 

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract. To find more information about access levels, go to: 
www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 
www.managementsoftware.hp.com/passport-registration.html
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Welcome to This Tutorial

Welcome to this tutorial, a self-paced guide that teaches you how to use 
HP Quality Center, the HP Web-based test management tool. 

This tutorial instructs you on how to use Quality Center to manage the 
application testing process. It familiarizes you with the process of defining 
releases, specifying requirements, planning tests, executing tests, tracking 
defects, alerting on changes, and analyzing results. It also shows you how to 
customize your project.

Before You Begin

To work with this tutorial, your Quality Center client machine must have 
access to these components:

➤ QualityCenter_Demo—a demo project that helps introduce you to 
Quality Center and includes sample releases, requirements, tests, test sets, 
test runs, and defects.

Note: It is highly recommended that you work on a new copy of the 
QualityCenter_Demo project. For more information, contact your 
Quality Center site administrator.

➤ Mercury Tours—a sample application that simulates a Web-based site for 
reserving flights, hotel rooms, car rentals, cruises, and vacation deals.
7



Welcome to This Guide
Note: The QualityCenter_Demo project and the Mercury Tours application 
can be installed only during the installation of Quality Center on a server 
machine. For more information, refer to the HP Quality Center Installation 
Guide.

➤ To run the automated tests in this tutorial, you must have 
QuickTest Professional or WinRunner installed on your machine. 

Note: 

➤ To integrate Quality Center with QuickTest Professional, you must install 
the HP QuickTest Professional Add-in and the HP Quality Center 
Connectivity Add-in from the HP Quality Center Add-ins page. 

➤ To integrate Quality Center with WinRunner, you must install the 
HP Quality Center Connectivity Add-in from the HP Quality Center 
Add-ins page.

For more information, refer to the HP Quality Center Installation Guide.

How This Tutorial is Organized

This tutorial contains the following lessons: 

 Lesson 1 Introducing Quality Center

Introduces you to the Quality Center testing process, and familiarizes you 
with the Quality Center user interface and the sample Mercury Tours Web 
site.

 Lesson 2 Specifying Releases and Cycles

Shows you how to define releases and cycles and monitor their progress and 
quality.
8



Welcome to This Guide
 Lesson 3 Specifying Requirements

Shows you how to define requirements, view and modify the requirements 
tree, and convert requirements to tests.

 Lesson 4 Planning Tests

Shows you how to create a test plan tree, design test steps, copy test steps, 
call a test with parameters, link tests to requirements, and automate your 
manual tests.

 Lesson 5 Running Tests

Shows you how to define test sets, schedule test runs, and run manual and 
automated tests.

 Lesson 6 Adding and Tracking Defects

Shows you how to add new defects, search for similar defects, update 
defects, link defects to tests, trace changes, and create favorite views.

 Lesson 7 Alerting on Changes

Shows you how to keep track of changes made to your requirements, tests, 
and defects as you perform your project testing.

 Lesson 8 Analyzing the Testing Process

Shows you how to monitor the testing process by creating reports and 
graphs.

 Lesson 9 Customizing Projects

Shows you how to set up project users, and how to create project fields and 
lists.

 Lesson 10 Where Do You Go from Here?

Shows you how to start testing your own application and where to find 
more information about Quality Center.
9



Welcome to This Guide
Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
10



1
Introducing Quality Center

Application testing is a complex process. Quality Center helps you organize 
and manage all phases of the application testing process, including defining 
releases, specifying requirements, planning tests, executing tests, and 
tracking defects.

In this lesson, you will learn about: On page:

The Quality Center Testing Process 12

Starting Quality Center 13

The Quality Center Window 16

The Mercury Tours Sample Web Site 19
11



Lesson 1 • Introducing Quality Center
The Quality Center Testing Process

Quality Center offers an organized framework for testing applications before 
they are deployed. Because test plans evolve with new or modified 
application requirements, you need a central data repository for organizing 
and managing the testing process. Quality Center guides you through all 
phases of the testing process.

The Quality Center testing process includes five phases:

➤ Specifying Releases. Develop a release-cycle management plan.

➤ Specifying Requirements. Identify and validate the functional and 
performance requirements that need to be tested.

➤ Planning Tests. Plan and confirm which tests need to be performed and how 
these tests must be run.

➤ Running Tests. Organize test sets, schedule their execution, perform test 
runs, and analyze the results of these runs.

➤ Tracking Defects. Add defects that were detected in the application and 
track how repairs are progressing.

Throughout the testing process, you can generate reports and graphs to 
assist you in your “go/no-go” decisions about your application readiness.
12



Lesson 1 • Introducing Quality Center
Starting Quality Center

You start Quality Center from your Web browser using the 
HP Quality Center URL.

To start Quality Center:

 1 Open the Quality Center Options window.

Open your Web browser and type your Quality Center URL:
http://<Quality Center server name>[:<port number>]/qcbin. Contact your 
system administrator if you do not have the correct path.

The Quality Center Options window opens.

 2 Open Quality Center.

Click the Quality Center link.

The first time you run Quality Center, files are downloaded to your 
machine. Subsequently, Quality Center carries out a version check. If there 
is a newer version on the server, updated files are downloaded to your 
machine. 
13



Lesson 1 • Introducing Quality Center
Note: Quality Center prompts you to install Microsoft .NET Framework 2.0 
if it is not already installed on your machine. To perform the installation, 
follow the instructions in the Software Update Installation Wizard (if 
Windows Installer 3.1 is not installed) and in the Microsoft .NET 
Framework 2.0 Setup.

The Quality Center Login window opens.

 3 Type a user name and authenticate.

In the Login Name box, type one of the following names: alice_qc, cecil_qc, 
or michael_qc.

Skip the Password box. A password was not assigned to any of the above 
user names.
14



Lesson 1 • Introducing Quality Center
Tip: If you previously logged in to a project, you can select the Automatically 
log in to my last domain and project on this machine check box if you want 
Quality Center to automatically log in to the last project in which you were 
working.

Click the Authenticate button. Quality Center verifies your user name and 
password and determines which domains and projects you can access.

 4 Log in to the project.

In the Domain list, select DEFAULT.

In the Project list, select QualityCenter_Demo.

Note: If more than one QualityCenter_Demo project is listed, contact your 
Quality Center site administrator to determine which project to use.

Click the Login button.

When you log in to a project, the Quality Center main window opens and 
displays the module in which you were last working. In the upper-right 
corner of the window, the domain name, project name, and your user name 
are displayed.

The first time you run Quality Center, the Welcome page opens. From the 
Welcome page, you can directly access this Tutorial and other 
Quality Center documentation. If you do not want to display the Welcome 
page each time you log in to Quality Center, select Don’t show this again. 
To open the Welcome page at any time, choose Help > Welcome Page.
15



Lesson 1 • Introducing Quality Center
The Quality Center Window

In this exercise, you will explore the Quality Center modules and their 
common elements.

To explore the Quality Center window:

 1 Explore the Quality Center modules.

➤ Click the Releases button on the sidebar. The Releases module enables you 
to define releases and cycles for managing the testing process.

➤ Click the Requirements button on the sidebar. The Requirements module 
enables you to specify your testing requirements. This includes defining 
what you are testing, defining requirement topics and items, and analyzing 
the requirements.

➤ Click the Test Plan button on the sidebar. The Test Plan module enables you 
to develop a test plan based on your testing requirements. This includes 
dividing your plan into categories, developing tests, automating tests where 
beneficial, and analyzing the plan.

➤ Click the Test Lab button on the sidebar. The Test Lab module enables you 
to run tests on your application and analyze the results.

➤ Click the Defects button on the sidebar. The Defects module enables you to 
add defects, determine repair priorities, repair open defects, and analyze the 
data.

Note: Depending on your Quality Center license, you may also have access 
to the Business Components module. The Business Components module 
enables subject matter experts to drive the quality optimization process. For 
more information, refer to the HP Business Process Testing User’s Guide.
16



Lesson 1 • Introducing Quality Center
 2 Explore the common Quality Center elements.

All the Quality Center modules have common elements. For example, click 
the Requirements button on the sidebar.
17



Lesson 1 • Introducing Quality Center
Each of the Quality Center modules contains the following key elements:

➤ Quality Center common toolbar. This is located in the upper-right corner 
of the window. It is accessible from all modules and contains the 
following buttons:

➤ Module menu bar. Displays the names of menus from which you select 
commands in the current Quality Center module.

➤ Module toolbar. This is located below the menu bar. It contains buttons 
for frequently used commands in the current Quality Center module.

Button Description

Navigates back to your previous location in Quality Center.

Navigates forward to your next location in Quality Center.

Includes options that enable you to select a different project, 
customize your project, add new defects, check spelling and 
grammar, delete history data from your project, open the 
Document Generator, generate Excel reports, and open Dashboard.

For more information on the Tools button, refer to the 
HP Quality Center User’s Guide.

Enables you to open the Quality Center Documentation Library 
and other additional online resources. It also enables you to display 
version information for each Quality Center client component. For 
more information, see “Documentation Library” on page 164 and 
“Additional Online Resources” on page 166.

Enables you to log you out of your current project to the 
HP Quality Center Login window. 
18



Lesson 1 • Introducing Quality Center
The Mercury Tours Sample Web Site

Mercury Tours is the sample Web application used in this tutorial. It 
simulates a Web-based application for reserving flights, hotel rooms, car 
rentals, cruises, and vacation deals. You should now familiarize yourself 
with this application.

To explore Mercury Tours:

 1 Open the Mercury Tours application.

Open a separate instance of your Web browser, and type this URL: 
http://<Quality Center server name>[<:port number>]/mtours

The Mercury Tours home page opens.
19



Lesson 1 • Introducing Quality Center
 2 Register with Mercury Tours.

Click Register. The Register page opens. 

Under User Information, enter any user name and password, and confirm 
your password. (Other information is not required.)

Click Submit. Mercury Tours confirms your registration.
20



Lesson 1 • Introducing Quality Center
 3 Log on to Mercury Tours. 

Click Sign-on. The Sign-on page opens. 

Type your registered user name and password. Click Submit.
21



Lesson 1 • Introducing Quality Center
The Flight Finder page opens.

 4 Reserve a flight. 

Follow the on-screen instructions to reserve a flight. 

 5 End your Mercury Tours session. 

Click Sign-off to log out.

Now that you are familiar with the Quality Center testing process, the 
Quality Center modules, and the Mercury Tours sample Web site, you can 
proceed to Lesson 2, “Specifying Releases and Cycles.” In Lesson 2, you will 
learn how to define your releases and cycles.
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2
Specifying Releases and Cycles

You begin the testing process by specifying releases in the Releases module. 
A release represents a group of changes in one or more applications that will 
be available for distribution at the same time. Each release can contain a 
number of cycles. A cycle represents a development and QA cycle based on 
the project timeline. The releases and cycles have defined start and end 
dates.

After you create requirements in the Requirements module, you assign them 
to releases and cycles (see the lesson “Specifying Requirements” on page 31). 
You later plan tests to test these requirements and run them as part of test 
sets, belonging to test set folders. Each test set folder is assigned to a cycle 
(see the lesson “Running Tests” on page 73). When you begin logging 
defects, you can assign them to specific cycles (see the lesson “Adding and 
Tracking Defects” on page 105). In this way, you can keep track of the 
progress and quality of your release.

In this lesson, you will learn about: On page:

Defining Releases and Cycles 24

Viewing Releases and Cycles 26
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Lesson 2 • Specifying Releases and Cycles
Defining Releases and Cycles

In this exercise, you will define a release and its constituent cycles. Releases 
and cycles each have start dates and end dates. The date range for a cycle 
must be contained within the date range for the release to which it belongs.

To define a release and its cycles:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log in to the project. 
For more information, see “Starting Quality Center” on page 13.

 2 Display the Releases module.

Click the Releases button on the sidebar.

 3 Create a new release folder.

In the releases tree, select the root Releases folder. Click the New Release 
Folder button. The New Release Folder dialog box opens.

In the Release Folder Name box, type Service Packs.

Click OK. The Service Packs release folder is added to the releases tree.

In the Description box in the right pane, type the following description for 
the release folder: This folder contains service pack releases.

 4 Add a release.

In the releases tree, make sure that the new Service Packs release folder is 
selected.
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Lesson 2 • Specifying Releases and Cycles
Click the New Release button.The New Release dialog box opens.

In the Release Name box, type Service Pack 1.

Click OK. The Service Pack 1 release is added to the Service Packs release 
folder.

In the right pane, in the Start Date box, click the down arrow and select 
yesterday’s date. In the End Date box, click the down arrow and select the 
date two months from today’s date. In the Description box, type the 
following description for the release: This release is the first service pack 
release.

 5 Add a cycle to the release.

In the releases tree, select the Service Pack 1 release.

Click the New Cycle button.The New Cycle dialog box opens.

In the Cycle Name box, type Cycle 1 - New Features.

Click OK. The Cycle 1 - New Features cycle is added to the Service Pack 1 
release.

In the right pane, in the Start Date box, click the down arrow and select 
yesterday’s date. In the End Date box, click the down arrow and select the 
date a month from today’s date. In the Description box, type the following 
description for the cycle: This cycle tests new features added for this service 
pack.
25



Lesson 2 • Specifying Releases and Cycles
 6 Add a second cycle to the release.

In the releases tree, select the Service Pack 1 release.

Choose Releases > New Cycle. The New Cycle dialog box opens.

In the Cycle Name box, type Cycle 2 - Full.

Click OK. The Cycle 2 - Full cycle is added to the Service Pack 1 release.

In the right pane, in the Start Date box, click the down arrow and select the 
date one month and a day from today’s date. In the End Date box, click the 
down arrow and select the date two months from today’s date. In the 
Description box, type the following description for the cycle: This cycle fully 
tests all application features.

Viewing Releases and Cycles

You can view graphs and statistics to display the progress and quality of 
your releases and cycles. This exercise introduces these graphs and statistics. 
In later lessons, you will see how the graphs and statistics change to reflect 
the changing status of your project.

To view releases and cycles:

 1 Make sure the Releases module is displayed.

If the Releases module is not displayed, click the Releases button on the 
sidebar.
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Lesson 2 • Specifying Releases and Cycles
 2 Display the Progress graph for the Service Pack 1.

In the releases tree, select the Service Pack 1 release, located in the Service 
Packs release folder. In the right pane, click the Progress tab.

The Progress tab displays the progress of the release based on requirement 
coverage, elapsed and remaining time, and actual and remaining test 
instances to run. As you have not yet created requirements or tests, the 
information in the Coverage Progress graph indicates 0% progress.
27



Lesson 2 • Specifying Releases and Cycles
 3 Display the Quality graph for the Service Pack 1 release.

In the right pane, click the Quality tab.

The Defect Opening Rate graph summarizes the number of defects detected 
in the selected release. The defects are categorized according to their 
severity. The current status of the defects is not considered. As you have not 
yet reported defects, the graph is empty.

The Outstanding Defects graph summarizes the number of outstanding 
defects for the selected release. The defects are categorized according to their 
severity. By default, defects with the status of New, Open, and Reopen are 
displayed in the graph. 

Although you have not yet reported any defects, the graph shows 
outstanding defects. This is because some of the defects in this project are
not assigned to any release and therefore are considered to be 
outstanding. 
28



Lesson 2 • Specifying Releases and Cycles
 4 Display the Progress graph and Quality graph for a cycle.

In the releases tree, select the Cycle 1 - New Features cycle, located in the 
Service Pack 1 release. 

In the right pane, click the Progress tab. You can see that the information 
available is similar to that available for the release, but at the cycle level. As 
in the case of the release, you have not yet created requirements and tests, 
therefore the information in the Coverage Progress graph indicates 0% 
progress.

Now click the Quality tab. Both graphs are empty.

Now that you are familiar with defining and viewing releases and cycles, 
you can proceed to Lesson 3, “Specifying Requirements.” In Lesson 3, you 
will learn how to define your testing requirements. 
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3
Specifying Requirements

After you have defined releases and cycles, you specify requirements in the 
Requirements module. Requirements describe in detail what needs to be 
tested in your application and provide the test team with the foundation on 
which the entire testing process is based.

You define the requirements in Quality Center by creating a requirements 
tree. This is a graphical representation of your requirements specification, 
displaying your requirements hierarchically. You can group and sort 
requirements in the tree, monitor task allocation, monitor the progress in 
meeting requirements, and generate detailed reports and graphs.

After you create tests in the Test Plan module, you can link requirements to 
tests (see the lesson “Planning Tests” on page 47). Later, after you begin 
logging defects, you can also link requirements to defects (see the lesson 
“Adding and Tracking Defects” on page 105). In this way, you can keep track 
of your testing needs at all stages of the testing process. If a requirement 
changes, you can immediately identify which tests and defects are affected, 
and who is responsible for them.

In this lesson, you will learn about: On page:

Defining Requirements 32

Viewing Requirements 36

Modifying Requirements 39

Converting Requirements 41
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Lesson 3 • Specifying Requirements
Defining Requirements

In this exercise, you will define requirements for testing the functionality of 
reserving cruises in Mercury Tours.

Note: In addition to creating requirements directly in Quality Center, you 
can also import requirement data from Microsoft Word or Microsoft Excel to 
your Quality Center project. To import from Word, you must install the 
HP Quality Center Microsoft Word Add-in and the HP Quality Center 
Connectivity Add-in. To import from Excel, you must install the 
HP Quality Center Microsoft Excel Add-in and the HP Quality Center 
Connectivity Add-in. You can install the add-ins from the HP Quality Center 
Add-ins page. For more information, refer to the HP Quality Center 
Installation Guide.

To define a requirement:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log in to the project. 
For more information, see “Starting Quality Center” on page 13.

 2 Display the Requirements module.

Click the Requirements button on the sidebar.

Choose View > Requirements Tree to display requirements in a tree.

Note: This lesson uses the Requirements Tree view. For more information 
on the Requirements Grid view, see “Viewing Requirements” on page 36. 
For more information on the Requirements Details and Coverage Analysis 
views, see “Creating and Viewing Requirements Coverage” on page 61.
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Lesson 3 • Specifying Requirements
 3 Create a new requirement and assign it to a requirement type.

Expand the Requirements root requirement and select the Mercury Tours 
Application requirement. 

Click the New Requirement button. The Create New Requirement dialog 
box opens.

In the Requirement Type box, select Functional. Each requirement belongs 
to a requirement type. The requirement type to which a requirement 
belongs determines which fields are available for the requirement. Your 
project administrator can modify existing types and add new types. For 
more information on configuring requirement types, see the 
HP Quality Center Administrator’s Guide.

In the Requirement Name box, type Cruise Reservation.
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Lesson 3 • Specifying Requirements
Click OK. The New Requirement dialog box opens.

 4 Add details to the requirement.

Type or select the following:

Priority: 4-Very High

Product: Mercury Tours Web Site

Click Submit. The Cruise Reservation requirement is added to the 
requirements tree under the Mercury Tours Application requirement.

Click Close to close the New Requirement dialog box.
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Lesson 3 • Specifying Requirements
 5 Add a child requirement.

In the requirements tree, make sure that the new Cruise Reservation 
requirement is selected.

Click the New Requirement button to add a requirement below Cruise 
Reservation. In the Create New Requirement dialog box, select Functional in 
the Requirement Type box and type Cruise Search in the Requirement 
Name box. Click OK.

In the New Requirement dialog box, type or select the following:

Priority: 4-Very High

Product: Mercury Tours Web Site

Click Submit. The Cruise Search requirement is added as a child of the 
Cruise Reservation requirement.

Click Close to close the New Requirement dialog box.

 6 Add an additional child requirement.

In the requirements tree, select Cruise Reservation.

Repeat step 5. This time in the Requirement Name box, type Cruise Booking. 

The Cruise Booking requirement is added as a child of the Cruise 
Reservation requirement.
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Lesson 3 • Specifying Requirements
 7 Assign the requirements to a cycle.

In the requirements tree, select Cruise Reservation.

Choose Requirements > Assign to Cycle. The releases tree opens. In the 
Service Packs releases folder, in the Service Pack 1 release, select the check 
box for the Cycle 1 - New Features cycle. Click OK to close the releases tree. 
Click Yes to assign the cycle to the child requirements of the requirement as 
well as to the requirement itself.

In the columns displayed, you can see that Quality Center assigns the Cycle 
1 - New Features value to the Target Cycle field and the value Service Pack 1 
to the Target Release field. 

Viewing Requirements

You can change the way requirements are displayed. In this exercise, you 
will learn how to zoom in and out of the requirements tree, and how to 
display and filter requirements in the requirements grid.

To view requirements:

 1 Make sure the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar. 

Choose View > Requirements Tree to display requirements in the 
Requirements Tree view.

 2 Zoom in and out of the requirement tree.

Select Cruise Reservation in the requirements tree.
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Lesson 3 • Specifying Requirements
To zoom in, click the Zoom In button in the toolbar. The requirements tree 
displays only the child requirements of Cruise Reservation.

To reverse the zoom-in action and display the entire requirements tree, click 
the Zoom In arrow and choose Zoom Out To Root.

 3 View requirements in the requirements grid.

Choose View > Requirements Grid to display requirements in a flat non-
hierarchical view. Each line in the grid displays a separate requirement.

 4 Filter the requirements grid.

Click the Set Filter/Sort button. The Filter dialog box opens. 
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Click the Filter Condition box that corresponds to Creation Date. Click the 
browse button. The Select Filter Condition dialog box opens, displaying 
today’s date in the Condition box.

Select the date on which you added requirements, or accept the default date.

Click OK to close the Select Filter Condition dialog box.

Click OK to apply your chosen filter.

The Requirements Grid displays the requirements you added.
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Modifying Requirements

You can modify the requirements in the requirements tree. In this exercise, 
you will learn how to copy, rename, move, and delete requirements.

To modify requirements:

 1 Make sure the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar.

Choose View > Requirements Tree to display requirements in the 
Requirements Tree view.

 2 Copy a requirement.

In the requirements tree, right-click Cruise Reservation and choose Copy. 

Right-click the Mercury Tours Application requirement and choose Paste. 

A warning box opens because you are duplicating the requirement name. 
Click OK. The requirement is pasted under the selected requirement. 
_Copy_1 is added to the end of the requirement’s name. Note that the 
requirement was copied and pasted with its child requirements.

 3 Rename the Cruise Reservation_Copy_1 requirement.

Right-click the Cruise Reservation_Copy_1 requirement and choose 
Rename.

Change the requirement name to Hotel Reservations and press Enter.

 4 Move the Hotel Reservations requirement to a different location in the 
requirements tree.

Right-click the Hotel Reservations requirement and choose Cut.

To paste Hotel Reservations as a child of the Reservations Management 
requirement, right-click Reservation Management and choose Paste.
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Click Yes to confirm. 

Tip: You can also drag requirements to a new location in the requirements 
tree.

 5 Delete the Hotel Reservations requirement.

Select Hotel Reservations.

Click the Delete button. 

Click Yes to confirm. The requirement and its children are deleted.
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Converting Requirements

After you create the requirements tree, you use the requirements as a basis 
for defining your test plan tree in the Test Plan module. For more 
information, see the lesson “Planning Tests” on page 47.

Tip: You can also use risk-based quality management to analyze your 
requirements and use this analysis as a basis for planning your testing. For 
more information on risk-based quality management, see the 
HP Quality Center User’s Guide.

You can use the Convert to Tests wizard to assist you when designing your 
test plan tree. The wizard enables you to convert selected requirements or all 
requirements in the requirements tree to subjects or tests in the test plan 
tree.

In this exercise, you will convert the Cruise Reservation requirement to a 
subject in the test plan tree, and the child requirements of Cruise 
Reservation to tests in the Cruise Reservation subject folder.

To convert a requirement:

 1 Make sure the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar.

Choose View > Requirements Tree to display requirements in the 
Requirements Tree view.

 2 Select a requirement.

In the requirements tree, select Cruise Reservation. 
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 3 Open the Convert to Tests wizard.

Choose Requirements > Convert to Tests. The Step 1 dialog box opens.

 4 Choose an automatic conversion method.

Select the second option, Convert lowest child requirements to tests, to 
convert the selected requirement to a subject folder, and its child 
requirements to tests.
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 5 Start the conversion process.

Click Next to begin converting the requirements. When the conversion 
process is complete, the results are displayed in the Step 2 dialog box.
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 6 Convert Cruise Search to a step and restore it.

To convert the Cruise Search test to a step, select Cruise Search and click the 
Convert to Step button. The Cruise Search test is converted to a step.

To restore the Cruise Search test, select Cruise Search and click the Convert 
to Test button. The Cruise Search step is converted back to a test.

Click Next. The Step 3 dialog box opens.
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 7 Choose the destination subject path.

In the Destination Subject Path box, click the browse button. The Select 
Destination Subject dialog box opens.

In the test plan tree, select the Cruises subject.

Click OK to close the Select Destination Subject dialog box. The Destination 
Subject Path box now indicates this path:

 8 Finalize the conversion process.

Click Finish.

Click OK.
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 9 View the tests in the test plan tree.

Click the Test Plan button on the sidebar to display the Test Plan module.

In the test plan tree, expand Cruises. The test plan tree displays Cruise 
Reservation under Cruises. 

Expand Cruise Reservation. The test plan tree displays the Cruise Booking 
and Cruise Search tests.

Now that you are familiar with defining requirements, viewing and 
modifying the requirements tree, and converting requirements, you can 
proceed to Lesson 4, “Planning Tests.” In Lesson 4, you will learn how to 
define your test plan tree. 
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4
Planning Tests

After you define your requirements, you need to determine your testing 
goals. To do this, examine your application, system environment, and 
testing process to outline the testing strategy for achieving your goals. 

After you determine your testing goals, you build a test plan tree, which 
hierarchically divides your application into testing units, or subjects. For 
each subject in the test plan tree, you define tests that contain steps.

For each test step, you specify the actions to be performed on your 
application and the expected result. You can increase the flexibility of a test 
step by adding parameters.

To keep track of the relationship between your tests and your requirements, 
you can add links between them. This can help you ensure compliance with 
your requirements throughout the testing process. 

After you design your tests, you can decide which tests to automate. When 
you automate a test, you can generate a test script and then complete it 
using other HP testing tools (for example, QuickTest Professional or 
WinRunner).

In this lesson, you will learn about: On page:

Developing a Test Plan Tree 48

Designing Test Steps 51

Copying Test Steps 55

Calling Tests with Parameters 57

Creating and Viewing Requirements Coverage 61

Generating Automated Test Scripts 70
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Developing a Test Plan Tree

The typical application is too large to test as a whole. The Test Plan module 
enables you to divide your application according to functionality. You 
divide your application into units, or subjects, by creating a test plan tree. The 
test plan tree is a graphical representation of your test plan, displaying your 
tests according to the hierarchical relationship of their functions. After you 
define subjects in the tree, you decide which tests to create for each subject, 
and add them to the tree.

In Lesson 3, you converted the Cruise Reservation requirement and its child 
requirements to subjects and tests in the test plan tree (see “Converting 
Requirements” on page 41). In this exercise, you will add a subject and a test 
to the test plan tree in the Test Plan module.

Note: In addition to creating a test plan tree directly in Quality Center, you 
can also import test plan data from Microsoft Word or Microsoft Excel to 
your Quality Center project. To import from Word, you must install the 
HP Quality Center Microsoft Word Add-in and the HP Quality Center 
Connectivity Add-in. To import from Excel, you must install the 
HP Quality Center Microsoft Excel Add-in and the HP Quality Center 
Connectivity Add-in. You can install the add-ins from the HP Quality Center 
Add-ins page. For more information, refer to the HP Quality Center 
Installation Guide.

To develop a test plan tree:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log in to the project. 
For more information, see “Starting Quality Center” on page 13.

 2 Display the Test Plan module.

Click the Test Plan button on the sidebar. 
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 3 Add a subject folder to the test plan tree.

Select the Cruises subject folder and click the New Folder button. The New 
Folder dialog box opens.

In the Folder Name box, type Cruise Cancellation. Click OK. The new subject 
folder appears under the Cruises subject folder in the test plan tree. 

In the Description tab in the right pane, type a description of the subject: 
This folder contains tests that verify the Cancel Reservation functionality.

 4 Add a test to the subject folder.

Select the Cruise Cancellation folder and click the New Test button. The 
Create New Test dialog box opens.

In the Test Type box, select QUICKTEST_TEST to create a 
QuickTest Professional test, or select WR-AUTOMATED to create a 
WinRunner test. 
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Note: 

➤ The QUICKTEST_TEST test type is available only if you have installed the 
HP QuickTest Professional Add-in from the HP Quality Center Add-ins 
page. For more information on installing the add-in, refer to the 
HP Quality Center Installation Guide.

➤ If you selected QUICKTEST_TEST from the Test Type list, the Template 
box is available on the Create New Test dialog box. You can create your 
new test based on another QuickTest Professional test, defined as a 
template test. Quality Center copies the template test to your new test 
without the test results. For more information about template tests, refer 
to the HP Quality Center User’s Guide.

In the Test Name box, type a name for the test: Cancel All Reservations. 

Click OK. The Required Test Fields dialog box opens.

Select the following:

Level: Basic 

Reviewed: Not Reviewed

Priority: 4-Very High

Click OK. 
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The new test is added to the test plan tree under the Cruise Cancellation 
subject folder.

 5 Add a test description.

In the Details tab, you can see the test name, test designer, creation date, test 
status, and other information.

In the Description tab, type a description for the test: The test verifies 
cancellation of cruise reservations in the Itinerary page.

Designing Test Steps

After you add a test to the test plan tree and define basic test information, 
you define test steps—detailed, step-by-step instructions that specify how to 
execute the test. A step includes the actions to be performed on your 
application and the expected results.

You can create test steps for both manual and automated tests. For manual 
tests, you complete test planning by designing the test steps. Using your 
plan, you can begin test execution immediately. For automated tests, you 
create automated test scripts using HP testing tools, custom testing tools, or 
third-party testing tools. 

In this exercise, you will create the Cruise Booking test. This test verifies the 
process of booking a cruise through the Mercury Tours site. 
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To design a test step:

 1 Make sure the Test Plan module is displayed.

If the Test Plan module is not displayed, click the Test Plan button on the 
sidebar. 

 2 Display the Cruise Booking test.

Expand the Cruises and Cruise Reservation subject folders, and select the 
Cruise Booking test.

 3 Open the Design Step Editor.

Click the Design Steps tab.

Click the New Step button. The Design Step Editor opens. 

In the Step Name box, a step name is displayed. The default name is the 
sequential number of the test step (Step 1 if you are adding steps to a test for 
the first time). 
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 4 Define a step for displaying the Cruise Special page.

In the Design Step Editor, type the following:

Step Name: Display the Cruise Special page. 

Description: Click the Cruises button. 

Expected Result: The Cruise Special page opens. 

 5 Define a step for reserving the cruise.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 2.

Type the following:

Step Name: Display the Cruise Reservation page.

Description: Click the Now Accepting Reservations button.

Expected Result: The Cruise Reservation page opens.
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 6 Define a step for booking the cruise.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 3.

Type the following:

Step Name: Book the cruise.

Description: Enter passenger name, credit card information, and address. Click 
OK. 

Expected Result: The Cruise Confirmation page opens.

 7 Define a step for printing the cruise confirmation information.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 4.

Type the following:

Step Name: Print cruise confirmation.

Description: Click the Print button. 

Expected Result: A confirmation page is printed.

 8 Define a step for logging off the Mercury Tours site.

In the Design Step Editor, click the New Step button. The Step Name box 
displays Step 5.

Type the following:

Step Name: Log off.

Description: Click the Sign-Off button. 

Expected Result: Returns to the Sign-On page.
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 9 Close the Design Step Editor.

Click OK. The Design Steps tab displays the design steps.

Copying Test Steps

You can copy steps from another test in the same project or from a different 
project. In this exercise, you will copy the test steps from the Cruise Booking 
test and paste them into the Cruise Search test. 

To copy a test step:

 1 Display the Design Steps tab for the Cruise Booking test.

In the test plan tree, expand the Cruises and Cruise Reservation subject 
folders, and select the Cruise Booking test.

Click the Design Steps tab.
55



Lesson 4 • Planning Tests
 2 Select the steps that you want to copy.

Position the mouse pointer in the gray sidebar on the left. The mouse 
pointer changes to an arrow. Press the Shift or Ctrl key and select each step.

 3 Copy the selected steps.

Click the Copy Steps button.

 4 Paste the steps into the Cruise Search test.

In the test plan tree, expand the Cruises and Cruise Reservation subject 
folders, and select the Cruise Search test.

In the Design Steps tab, click the Paste Steps button. The test steps are 
copied to the Design Steps tab.
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Calling Tests with Parameters

When you design test steps, you can include a call to a manual test. When 
you run the test, the test steps include the steps from the called test as part 
of the test. The test that you call is a template test. This is a reusable test that 
can be called by other tests. A template test can include parameters. A 
parameter is a variable that replaces a fixed value. You can modify the value 
of a parameter according to the test that is calling it, or for various instances 
of the same test. 

For example, suppose you have a test that logs in a user with a specific 
password when you start your application. You need to call this test at the 
beginning of each test. In some cases, you may want to log in as a regular 
user while in other cases, you may want to log in as the administrator. To 
accomplish this, you create two parameters, <<<user name>>> and 
<<<password>>>, and modify the value of each parameter according to the 
type of test that is calling your template test.

In “Designing Test Steps” on page 51, you created a test for booking a cruise. 
In this exercise, you will enhance your test by calling the Connect And 
Sign-On test. This template test includes parameters for the Mercury Tours 
URL address and for the user name and password used to log in to the site.
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To call a test with parameters:

 1 Display the Design Steps tab for the Cruise Booking test.

In the test plan tree, expand the Cruises and Cruise Reservation subject 
folders, and select the Cruise Booking test.

Click the Design Steps tab.

 2 Select the test with parameters that you want to call.

Click the Call to Test button. The Select a Test dialog box opens.

In the Find box, type Connect, and click the Find button. The Connect And 
Sign-On test is highlighted.
58



Lesson 4 • Planning Tests
Click OK. The Parameters of Test dialog box opens and displays the 
parameters contained in the called test.

 3 Assign values to the parameters.

In the Value column, type the following:

mercury tours url: http://<Quality Center server name>[:<port number>]/mtours

password: Leave blank. You will assign a value to this parameter when you 
run your test (see “Running Tests Manually” on page 89).

user name: Your user name. Use the same name as the one used in Mercury 
Tours. For more information, see “The Mercury Tours Sample Web Site” on 
page 19.

Click OK. The Call Connect And Sign-On step is added to your design steps.
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 4 Reorder the steps.

Position the mouse pointer on the gray sidebar to the left of the 
Call Connect And Sign-On step. The mouse pointer changes to an arrow. 
Click and drag the step to the top row.
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Creating and Viewing Requirements Coverage

It is essential that the tests in your test plan comply with your testing 
requirements. To help ensure compliance throughout the testing process, 
you can add links between your tests in the Test Plan module and your 
requirements in the Requirements module.

In the Test Plan module, you create requirements coverage by selecting 
requirements to link to a test. Alternatively, in the Requirements module, 
you create tests coverage by selecting tests to link to a requirement. A test can 
cover more than one requirement, and a requirement can be covered by 
more than one test.

To further ensure compliance with your testing requirements, after you log 
defects, you can link your requirements and tests to defects (see “Linking 
Defects to Tests” on page 115). This ensures that if a requirement changes, 
you can identify which tests and defects are affected, and who is responsible 
for them.

In these exercises, you will learn about the following:

➤ Linking Requirements to a Test

➤ Linking Tests to a Requirement

➤ Analyzing Tests Coverage

Linking Requirements to a Test
In this exercise you will view existing requirements coverage for the Cruise 
Booking test and create new requirements coverage by linking the Cruise 
Search requirement to the Cruise Booking test. 

You will also add requirements coverage for the following tests: Cancel All 
Reservations, Airline Preference, and Number of Passengers.

To link a requirement to a test:

 1 Make sure that the Test Plan module is displayed.

If the Test Plan module is not displayed, click the Test Plan button on the 
sidebar. 
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 2 Display the Cruise Booking test.

Expand the Cruises and Cruise Reservation subject folders, and select the 
Cruise Booking test.

 3 Display the Req Coverage tab.

In the right pane, click the Req Coverage tab. The existing requirements 
coverage is displayed in the coverage grid. Note that the Cruise Booking 
requirement is already linked to the Cruise Booking test because you 
converted the requirement to a test (see “Converting Requirements” on 
page 41).

 4 Display the requirements tree.

Click the Select Req button and expand the requirements tree displayed on 
the right.

 5 Add the Cruise Search requirement to the coverage grid.

In the requirements tree in the right pane, under Cruise Reservation, select 
Cruise Search. 
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Click the Add to Coverage (Without Children) button. The Cruise Search 
requirement is added to the coverage grid. 

Tip: You can also drag a requirement in the requirements tree to the 
coverage grid. The requirement is added to the coverage grid without its 
child requirements.

 6 Add coverage to the Cancel All Reservations test.

In the test plan tree, expand the Cruises and Cruise Cancellation subject 
folders, and select the Cancel All Reservations test.

In the requirements tree in the right pane, under Cruise Reservation, select 
Cruise Search and drag the requirement to the coverage grid. Select Cruise 
Booking and drag the requirement to the coverage grid.

 7 Add coverage to the Airline Preference test.

In the test plan tree, expand the Flight Reservation and Flight Finder subject 
folders, and select the Airline Preference test.

In the requirements tree in the right pane, under Cruise Reservation, select 
Cruise Search and drag the requirement to the coverage grid. Select Cruise 
Booking and drag the requirement to the coverage grid.

 8 Delete coverage for the Airline Preference test.

In the coverage grid, select Flight Tickets. Click the Remove Selected button. 
Click Yes to confirm.

Select Airline Company and click the Remove Selected button. Click Yes to 
confirm.

 9 Add coverage to the Number of Passengers test.

In the test plan tree, expand the Flight Reservation and Flight Finder subject 
folders, and select the Number of Passengers test.

In the requirements tree in the right pane, under Cruise Reservation, select 
Cruise Search and drag the requirement to the coverage grid. 

 10 Hide the requirements tree.

Click the Close button.
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Linking Tests to a Requirement
In this exercise, you will create tests coverage by linking the Cruise Search 
test to the Cruise Booking requirement.

To link a test to a requirement:

 1 Display the Requirements module.

Click the Requirements button on the sidebar. 

 2 Display the requirements tree in Requirement Details View.

Choose View > Requirement Details. The Requirement Details view is 
displayed.

 3 Display the Cruise Booking requirement.

In the requirements tree, expand the Cruise Reservation folder, and select 
the Cruise Booking requirement.

 4 Display the Test Coverage tab.

In the right pane, click the Test Coverage tab. The coverage grid indicates 
that the Cruise Booking requirement is already linked to the following tests: 
Cruise Booking, Cancel All Reservations, and Airline Preference.
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 5 Display the test plan tree.

In the Test Coverage tab, click the Select Tests button to show the test plan 
tree on the right.

 6 Select the Cruise Search test in the test plan tree.

In the Test Plan Tree tab, expand the Cruises and Cruise Reservation subject 
folders, and select the Cruise Search test.

 7 Add the test to the coverage grid.

Click the Add to Coverage button. The Cruise Search test is added to the 
coverage grid. 

Tip: You can also drag a test or a subject folder in the Test Plan Tree to the 
coverage grid.

 8 Hide the test plan tree.

Click the Close button above the tests plan tree.
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Analyzing Tests Coverage
After you create tests coverage, you can use the Coverage Analysis view in the 
Requirements module to analyze the breakdown of child requirements 
according to tests coverage. 

In this exercise, you will analyze the Application Client System requirement. 
In the Coverage Analysis view, you will see that two of the requirement’s 
children have a “Failed” status (one or more of the tests covered by the 
requirement failed) and nine have a “Not Covered” status (the requirement 
has not been linked to a test). You will then analyze the failed requirements 
in more detail.

To analyze tests coverage:

 1 Make sure that the Requirements module is displayed.

If the Requirements module is not displayed, click the Requirements button 
on the sidebar.

 2 Display the requirements tree in Coverage Analysis view.

Choose View > Coverage Analysis. The Coverage Analysis view is displayed. 
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 3 Display the Application Client System requirement in Coverage Analysis 
view.

Under the Mercury Tours Application requirement, expand the Application 
Client System requirement and its children.

In the Coverage Analysis column, you can see graphically that of the eleven 
children that have a direct cover status, only two have “Failed” and nine are 
not yet covered. Note that the Application Client System, Hardware, 
Monitor, Software, Operating System, and Browser requirements do not 
have a direct cover status as they belong to requirement types that do not 
support coverage.
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 4 Display coverage analysis for the Application Client System requirement.

Right-click the Application Client System requirement, and choose 
Coverage Analysis. The Coverage Analysis dialog box opens.

This graph displays the two “Failed” requirements in red and the nine “Not 
Covered” requirements in white.

 5 Display the child requirements with a “Failed” status.

Click the red Failed area of the graph. The child requirements with a 
“Failed” status are listed.

Note that you can select a requirement and click Go To to highlight the 
requirement in the requirements tree.
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 6 Display tests coverage for the requirement.

Click the Show Tests Coverage link to extend the Coverage Analysis dialog 
box and display the Tests Coverage Chart. 

You can see, for example, that one (9.09%) of the tests associated with the 
Application Client System requirement has a “Failed” status. Seven of the 
associated tests (63.64%) have a “Passed” status.

Note that you can click a section of the chart to open the Tests Coverage 
dialog box and display the list of tests with the selected status.

 7 Close the Coverage Analysis dialog box.

Click the Close button. 
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Generating Automated Test Scripts

Test planning involves deciding which tests to automate. If you choose to 
perform tests manually, the tests are ready for execution as soon as you 
define the test steps. If you choose to automate tests, you can generate test 
scripts and complete them using other HP testing tools (for example, 
QuickTest Professional or WinRunner).

Consider these issues when deciding whether to automate a test.

In this exercise, you will generate an automated test script for the Address 
Options test.

To generate an automated test script:

 1 Display the Test Plan module.

Click the Test Plan button on the sidebar. 

Do automate: ➤ Tests that will run with each new version of your 
application to check the stability of basic functionality 
across the entire application (regression tests). 

➤ Tests that use multiple data values for the same operation 
(data-driven tests). 

➤ Tests that are run many times (stress tests) and tests that 
check a multi-user client/server system (load tests). 

Do not automate: ➤ Tests that will be executed only once.

➤ Tests that require immediate execution.

➤ Tests that check how easy the application is to use 
(usability tests).

➤ Tests that do not have predictable results.
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 2 Locate the Address Options manual test.

Select the Subject folder at the root of the test plan tree and choose 
Edit > Find. The Find Folder/Test dialog box opens.

In Value To Find, type Book.

Select the Include Tests checkbox to search for folders and tests.

Click Find. The Search Results dialog box opens and displays a list of 
possible matches.

Select Flight Reservation\Book Flight folder and click the Go To button to 
highlight the test in the test plan tree. Select the Address Options test.

Click Close to close the Search Results dialog box.

 3 Display the Design Steps tab.

In the right pane, click the Design Steps tab.

 4 Generate a test script.

Click the Generate Script button.

Choose QUICKTEST_TEST to generate a QuickTest Professional test, or 
choose WR-AUTOMATED to generate a WinRunner test.

Note: The QUICKTEST-TEST test type is only available if you have installed 
the HP QuickTest Professional add-in from the HP Quality Center Add-ins 
page. For more information on installing the add-in, refer to the 
HP Quality Center Installation Guide.
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The steps in the Address Options test are used to create an automated test 
script. In the test plan tree, note that the manual test with the steps icon  
next to the test is now replaced with the automated test icon.

 5 View the test script.

Click the Test Script tab.

To display and modify your test script in the testing tool in which it was 
created, click the Launch button.

Now that you are familiar with creating a test plan tree, designing test steps, 
copying test steps, calling a test with parameters, linking tests to 
requirements, analyzing tests coverage, and automating your manual tests, 
you can proceed to Lesson 5, “Running Tests.” In Lesson 5, you will learn 
how to run your manual and automated tests. 
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Running Tests

Running tests is the core of the testing process. As your application changes, 
you run manual and automated tests in your project to locate defects and 
assess quality.

You start by creating test sets and choosing which tests to include in each set. 
A test set is a group of tests in a Quality Center project designed to achieve 
specific testing goals. Quality Center enables you to control the execution of 
tests in a test set by setting conditions and scheduling the date and time for 
executing your tests.

After you define test sets, you can begin to execute your tests. You can then 
use Quality Center to view and analyze the results of your tests.

When you run a test manually, you execute the test steps you defined in test 
planning. You pass or fail each step, depending on whether the actual 
results match the expected output. When you run a test automatically, 
Quality Center opens the selected testing tool, which runs the test, and 
imports the test results to Quality Center.

In this lesson, you will learn about: On page:

Defining Test Sets 74

Adding Tests to a Test Set 80

Scheduling Test Runs 82

Running Tests Manually 89

Viewing and Analyzing Test Results 96

Running Tests Automatically 101
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Defining Test Sets

After you design tests in the Test Plan module, you create a test sets tree. A 
test sets tree enables you to organize your testing process by grouping test 
sets in folders and organizing them in different hierarchical levels in the Test 
Lab module. You assign each test set folder to a cycle. This enables you to 
group together test sets that will be run during the same cycle and analyze 
the progress of the cycle as you run your tests.

Test sets can include both manual and automated tests. You can also include 
instances of the same test in different test sets or add more than one 
instance to the same test set.

To decide which test sets to create, think about the testing goals you defined 
at the beginning of the testing process. Consider issues such as the current 
state of the application and the addition or modification of new features.

Following are examples of general categories of test sets you can create:

Test Set Description

Sanity Checks entire application at a basic level—focusing on 
breadth, rather than depth—to verify that the application is 
functional and stable. This set includes fundamental tests 
that contain positive checks, validating that the application 
is functioning properly. For example, in the Mercury Tours 
application, you could test whether the application opens 
and enables you to log in.

Regression Tests the system in a more in-depth manner than a sanity set. 
This set can include both positive and negative checks. 
Negative tests attempt to fail an application to demonstrate 
that the application is not functioning properly.

Advanced Tests both breadth and depth. This set covers the entire 
application, and also tests the application’s advanced 
options. You can run this set when there is ample time for 
testing.

Function Tests a subsystem of an application. This could be a single 
feature or a group of features. For example, in the Mercury 
Tours application, a function set could test all activities 
related to booking a flight.
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In this exercise, you will define the Mercury Tours Site test set. You will also 
set failure rules for the test set to instruct Quality Center how to proceed in 
the event that an automated test in the test set fails.

To define a test set:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log in to the project. 
For more information, see “Starting Quality Center” on page 13.

 2 Display the Test Lab module.

Click the Test Lab button on the sidebar.

Choose View > Test Sets Tree to display test sets in the test sets tree.

 3 Add a folder to the test sets tree.

In the test sets tree in the left pane, select the Root folder.

Click the New Folder button. The New Folder dialog box opens.

In the Folder Name box, type Service Pack 1 and click OK.

 4 Create subfolders for the test set folder.

Select the Service Pack 1 folder you created and repeat the previous step to 
create two subfolders, named Cycle 1 - New Features, and Cycle 2 - Full.
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 5 Assign the test set folders to a cycle.

Select the Cycle 1 - New Features test set folder and click the Assign to Cycle 
button. The Assign to Cycle dialog box opens. In the Service Packs releases 
folder, in the Service Pack 1 release, select the Cycle 1 - New Features cycle. 
Click OK to close the releases tree. The icon for the folder in the test sets tree 
changes to show that the folder has been assigned to a cycle.

Assign the Cycle 2 - Full test sets folder to the Cycle 2 - Full cycle, located in 
the Service Pack 1 release in the releases tree.

 6 Add a test set to the Cycle 1 - New Features test set folder.

In the test sets tree, select Cycle 1- New Features.

Click the New Test Set button. The New Test Set dialog box opens.
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Type the following:

Test Set Name: Mercury Tours Site

Description: This test set includes tests that verify the functionality of the 
Mercury Tours site.

Click OK. The Mercury Tours Site test set is added to the test sets tree in the 
left pane.

 7 Define the test set details.

Click the Test Set Properties tab and click the Details link. 

By default, the Status indicates that the test set is Open. 

Do the following:

Open Date: Select a date from the calendar for the planned opening date for 
the test set.

Close Date: Select the planned closing date for the test set.
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 8 Set rules for the automated tests in the test set in the event of a test failure. 

Click the On Failure link.

Do the following: 

On automated test failure: Select the first check box and make sure that the 
number of times an automated test can be rerun is set to 1. 

On final test failure: Make sure that the Do nothing option is selected.
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 9 Instruct Quality Center to send e-mail to specified users if certain events 
occur.

Click the Notifications link. 

Do the following:

Send e-mail in the event of: Select the first check box to send e-mail 
notification if any test in the test set fails. 

To: Type your e-mail address.

Message: Type the following: 
This test failed. Please review the test results and submit a defect. 
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Adding Tests to a Test Set

After you define a test set, you can add test instances to your test set. In this 
exercise, you will add test instances to the Mercury Tours Site test set.

To add a test to a test set:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

If the Test Sets Tree view is not displayed, choose View > Test Sets Tree.

 2 Display the Execution Grid tab.

In the test sets tree, expand the Cycle 1 - New Features test set folder under 
Service Pack 1. Select the Mercury Tours Site test set. 

Click the Execution Grid tab.

 3 Display the test plan tree if it is not already displayed.

Click the Select Tests button. The right pane displays the test plan tree.
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Note: If any filters are applied, it is recommended that you clear them:

➤ In the test plan tree, click the Set Filter/Sort arrow and choose Clear 
Filter/Sort. Click Yes to confirm.

➤ In the Execution Grid, click the Set Filter/Sort arrow and choose Clear 
Filter/Sort. Click Yes to confirm.

 4 Add the Cruises folder to the test set.

In the test plan tree, select the Cruises folder and click the Add Tests to Test 
Set button. 

Click Yes to confirm. The Parameters of Test dialog box opens because you 
are adding a test with an unassigned parameter value to a test set. Click 
Cancel to close the dialog box. You will assign this parameter value when 
you run the Cruise Booking test (see “Running Tests Manually” on page 89). 
The tests are added to the test set.

 5 Add the Airline Preference test to the test set.

To search for the test, in the Find box, type airline and click the Find button. 
The Airline Preference test is highlighted in the test plan tree.

Click the Add Tests to Test Set button. The test instance is added to the test 
set.

 6 Add the Number of Passengers test to the test set.

To search for the test, in the Find box, type Number of Passengers and click 
the Find button. The Number of Passengers test is highlighted in the test 
plan tree.

Click the Add Tests to Test Set button. The test is added to the test set.

 7 Close the test plan tree pane.

Click the Close button. 
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Scheduling Test Runs

The Execution Flow tab enables you to specify a date and time to execute a 
test instance and set conditions for it. A condition is based on the results of 
another specified test instance in the Execution Flow. By setting conditions, 
you can postpone the execution of a test instance until another specified 
test instance finishes running or passes. You can also set the sequence in 
which to execute the test instances. 

For example, you can schedule Test 2 to run only after Test 1 finishes, and 
Test 3 to run only if Test 2 passes. You can also schedule Test 1 and Test 2 to 
run a day before Test 3. The Execution Flow displays the tests and their 
conditions in a diagram. 
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Note: 

➤ A dashed line  arrow indicates a test with no conditions. 

➤ A solid line  arrow indicates a condition and can be blue or 
green. If the solid line is blue, it indicates that the condition is set to 
“Finished.” If the solid line is green, it indicates that the condition is set 
to “Passed.”

➤ A Time Dependency  icon is displayed for time-dependent tests.

In this exercise, you will create a new test set and add to it three test 
instances that verify the login procedure on the Sign-On page of the 
Mercury Tours site. Then, you will set the conditions for each test instance 
and specify when each one is to be run.

To schedule a test run:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

Choose View > Test Sets Tree to display test sets in the test sets tree.

 2 Create a new test set.

In the Test Lab module, click the Execution Flow tab. 
83



Lesson 5 • Running Tests
In the test sets tree, choose the Service Pack 1 folder and click the New Test 
Set button. The New Test Set dialog box opens.

Type the following:

Test Set Name: Test Run Schedule

Description: This test set is used to explain how to schedule a test run.

Click OK. The Test Run Schedule test set is added to the test sets tree in the 
left pane. 

 3 Add a test instance from the Sign-On/Sign-Off folder to the Test Run 
Schedule test set.

If the test plan tree is not open, click the Select Tests button. The test plan 
tree is displayed in the right pane.

In the Find box in the test plan tree, type sign and click the Find button to 
search for the Sign-On/Sign-Off folder. The Sign-On/Sign-Off folder is 
highlighted in the test plan tree.

Select the Sign-On Page test. Click the Add Tests to Test Set button. The 
Parameters of Test dialog box opens because you are adding a test instance 
with an unassigned parameter value to a test set. Click Cancel to close the 
dialog box. The test instance is added to the test set.
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 4 Add two additional test instances to the test set.

Drag the Sign-On User Name test to the Execution Flow area. The 
Parameters of Test dialog box opens. Click Cancel.

Double-click the Sign-On Password test to add it to the Execution Flow. The 
Parameters of Test dialog box opens. Click Cancel.

 5 Add an execution condition to the Sign-On User Name test.

Right-click the Sign-On User Name test instance and choose Test Run 
Schedule. The Run Schedule dialog box opens and displays the Execution 
Conditions tab. 
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Click New. The New Execution Condition dialog box opens.

In the Test box, select <[1]Sign-On Page>.

Select Passed to instruct Quality Center to execute the Sign-On User Name 
test instance only if the Sign-On Page test instance finishes executing and 
passes.

Click OK. The condition is added to the Run Schedule dialog box.
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 6 Add a time dependency condition to the Sign-On User Name test instance.

Click the Time Dependency tab.

Under Run At Specified Time, select the Date check box and select 
tomorrow’s date.

Click OK to close the Run Schedule dialog box. Your conditions are 
displayed in the Execution Flow diagram.

 7 Add an execution condition to the Sign-On Password test.

Add the same execution condition as described in Step 5 on page 85 for the 
Sign-On Password test. This time select Sign-On User Name from the Test 
box in the New Execution Condition dialog box.
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 8 Add a time dependency condition to the Sign-On Password test.

Add the same time dependency condition as described in Step 6 on page 87 
for the Sign-On Password test.

Click OK to close the Run Schedule dialog box. Your conditions are 
displayed in the Execution flow diagram.

 9 Rearrange the tests in a hierarchical layout.

Click the Arrange Layout button.
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Running Tests Manually

When you run a test manually, you follow the test steps and perform 
operations on your application. Then, you compare the expected results 
with the actual outcome and record the results. You can execute a manual 
test as many times as needed. The results are stored separately for each run. 

You can run both manual and automated tests manually. You can also 
choose to run a single test or to run an entire test set.

In this exercise, you will run the Cruise Booking and Cruise Search tests.

To run a test manually:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. Click the Execution Grid tab. 

Choose View > Test Sets Tree to display test sets in the test sets tree.

 2 Select the Mercury Tours Site test set.

In the test sets tree, expand the Cycle 1 - New Features test set folder under 
Service Pack 1. Select the Mercury Tours Site test set. 
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 3 Select the Cruise Booking test from the Execution Grid.

In the Execution Grid tab, select Cruise Booking.

Click the Run button. The Manual Runner dialog box opens.
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 4 Start the test run.

Click the Begin Run button. The Parameters Values for Run dialog box opens 
because you have an unassigned parameter in the test.
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 5 Assign a value for the password parameter.

Click the Value box for password and type the same password you used in 
Mercury Tours. For more information, see “The Mercury Tours Sample Web 
Site” on page 19.

Click OK. The Manual Runner: Step Details dialog box opens.
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 6 Display the Manual Runner dialog box in a compact view. 

Click the Compact view button. This enables you to read each step and 
record the results.

 7 Perform the first step.

Perform the procedure described in the Description box.

If the actual result is the same as the expected result, in the Actual box, type: 
The Mercury Tours site opens.

Click the Pass Selected button. Step 2 is displayed.

 8 Perform the second step.

Perform the procedure described in the Description box.

If the actual result is the same as the expected result, in the Actual box, type: 
The Flight Finder page opens.

Click the Pass Selected button. Step 3 is displayed.
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 9 Perform the third step.

Perform the procedure described in the Description box.

If the actual result is the same as the expected result, in the Actual box, type: 
The Cruise Special page opens.

Click the Pass Selected button. Step 4 is displayed.

 10 Perform the fourth step.

Perform the procedure described in the Description box.

If the actual result is different than the expected result, in the Actual box, 
type: The Flight Finder page opens instead of the Cruise Reservation page.

Click the Fail Selected button. 

Note: When you detect an application flaw while running the test, you can 
click the New Defect button to open the New Defect dialog box and add a 
defect. For the purpose of this exercise, you will submit this defect in 
“Adding New Defects” on page 107.

 11 Return to the default display of the Manual Runner.

Click the Back to Steps Grid button. The default display of the Manual 
Runner: Step Details dialog box is displayed. 

 12 End the test run.

Click the End Run button to end your test run.

 13 Run the Cruise Search test.

In the Execution Grid tab, select the test Cruise Search and click the Run 
button. The Manual Runner opens.

Perform the steps for the test as you did for the Cruise Booking test, but this 
time pass each step.
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 14 View the test run results in the Execution Grid.

Following the execution of your tests, you can view the test run results of 
your last run in the Execution Grid. Note that the test run status for the 
Cruise Booking test is updated from “No Run” to “Failed” and the test run 
status for the Cruise Search test is updated from “No Run” to “Passed.”

 15 View the results of each test step in the Last Run Result pane.

Select the Cruise Booking test. If the Last Run Result pane is not displayed, 
click the Show button on the bottom of the pane. The Last Run Result pane 
is displayed below the Execution Grid.

Click each step to view its description, as well as the expected and actual 
results.
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Viewing and Analyzing Test Results

Quality Center provides a number of features that enable you to view and 
analyze the results of your tests.

You can view detailed results for a test from the Test Instance Properties 
dialog box. This includes details of the test’s runs, attachments, linked 
defects, and history.

You previously saw how you can use the Coverage Analysis view to analyze 
the breakdown of child requirements according to their tests coverage (see 
“Analyzing Tests Coverage” on page 66). You can filter the tests included in 
this calculation by cycle. Quality Center includes in the calculation only 
tests instances belonging to test sets that are under test set folders that are 
assigned to cycles that match the filter. For example, suppose you plan to 
test a requirement in several cycles of a release. You may want to analyze the 
requirement’s coverage based only on the tests that are planned for the 
current cycle. You therefore filter the requirement coverage for the current 
cycle.

You were also previously introduced to the Progress tab in the Releases 
module (see “Viewing Releases and Cycles” on page 26). After you run tests 
in the Test Lab module, you can revisit this tab to see how the graphs and 
statistics change as the statuses of the tests in your releases and cycles 
change. This enables you to view a useful, high-level overview of the 
progress of your release.

In addition to these features, you can also use Quality Center reports and 
graphs to further analyze your test results. For more information, see 
Lesson 8, “Analyzing the Testing Process.”

In this exercise, you will view detailed results and analysis for the tests you 
ran in previous exercises.

To view and analyze test results:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

Choose View > Test Sets Tree to display test sets in the test sets tree.
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 2 Display the Mercury Tours Site test set in the Execution Grid.

Click the Execution Grid tab.

In the test sets tree, expand the Cycle 1 - New Features test set folder under 
Service Pack 1. Select the Mercury Tours Site test set. 

 3 Select the Cruise Booking test from the Execution Grid.

In the Execution Grid tab, select Cruise Booking.

 4 View detailed test results from the Test Instance Properties dialog box.

Click the Test Instance Properties button. The Test Instance Properties 
dialog box opens and displays the All Runs view.
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 5 View other test run information in the Test Instance Properties dialog box.

➤ To view run details of the test, click Details.

➤ To view manual parameters for a test, click Configuration and select the 
Manual tab. Note that any changes that you make will be implemented 
in the next test run.

➤ To view and manage defect links made to other Quality Center entities, 
click Linked Defects.

➤ To view a list of changes made to the test run fields, click History.

 6 Close the Test Instance Properties dialog box.

Click the Close button.

 7 Open the Requirements module in the Coverage Analysis view

Click the Requirements button on the sidebar.

Choose View > Coverage Analysis.

 8 Filter the tests included in the coverage analysis by cycle.

On the upper-right side of the window, click the browse button in the 
Coverage calculation by cycle box.

In the releases tree, expand the release folder Service Packs and the release 
Service Pack 1. Select the Cycle 1 - New Features check box and click OK.
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Expand the Cruise Reservation requirement. In the Coverage Analysis 
column, you can see that both sub-requirements have failed.

 9 Open the Releases module.

Click the Releases button on the sidebar.
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 10 View the effect of your test runs on the Progress tab.

In the releases tree, expand the release folder Service Packs and the release 
Service Pack 1. Select Cycle 1 - New Features. Click the Progress tab.

A day after Cycle 1 - New Features began, you can see that out of the 5 test 
instances, you have 3 remaining test instances to run. Under the Coverage 
Progress graph, the Planned coverage curve indicates that you have fully 
covered (100%) all of your assigned requirements with tests. The Executed 
coverage curve indicates that you ran 40% of your tests. The Passed 
coverage curve indicates that 20% of your tests ran successfully.
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Running Tests Automatically

When you run an automated test, Quality Center automatically opens the 
selected testing tool, which runs the test on your local machine or on 
remote hosts, and imports the results to Quality Center. 

Note that you can run all tests in a test set or run specific tests. You can run 
tests from the Execution Grid tab or the Execution Flow tab. 

In this exercise, you will run an automated test from the Mercury Tours Site 
test set.

Note: To perform this exercise, you must have QuickTest Professional or 
WinRunner installed on your machine.

➤ To integrate Quality Center with QuickTest Professional, you must install 
the HP QuickTest Professional Add-in and the HP Quality Center 
Connectivity Add-in from the HP Quality Center Add-ins page. 

➤ To integrate Quality Center with WinRunner, you must install the 
HP Quality Center Connectivity Add-in from the HP Quality Center 
Add-ins page.

For more information, refer to the HP Quality Center Installation Guide.

To run a test automatically:

 1 Make sure the Test Lab module is displayed.

If the Test Lab module is not displayed, click the Test Lab button on the 
sidebar. 

Choose View > Test Sets Tree to display test sets in the test sets tree.

 2 Display the Mercury Tours Site test set in the Execution Grid.

Click the Execution Grid tab.

In the test sets tree, expand the Cycle 1 - New Features test set folder under 
Service Pack 1. Select the Mercury Tours Site test set. 
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 3 Select a test.

To run a WinRunner test, select Airline Preference. 

To run a QuickTest Professional test, select Number of Passengers.

Click the Run button. The Automatic Runner dialog box opens and displays 
the selected test.

 4 Set the test run settings.

Select the Run All Tests Locally check box to run the test on your local 
computer.
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 5 Run the test.

Click the Run button. Quality Center opens the selected testing tool 
automatically and runs the test. You view the test execution progress in the 
Status column.

 6 Close the Automatic Runner dialog box.

After the test run is complete, choose Run > Exit.
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 7 View a summary of test results in the Execution Grid. 

The Execution Grid displays the updated status for the test run. Results for 
each test step appear in the Last Run Result pane.

 8 Close your selected testing tool.

In QuickTest Professional or WinRunner, choose File > Exit.

Now that you are familiar with how to define and build test sets, schedule 
test runs, run tests manually or automatically, and view and analyze test 
results, you can proceed to Lesson 6, “Adding and Tracking Defects.” In 
Lesson 6, you will learn how to add and track defects.
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Adding and Tracking Defects

Locating and repairing defects is an essential phase in application 
development. Defects can be detected and submitted by developers and 
testers in all stages of the testing process. Using Quality Center, you can 
submit defects detected in the application and track them until they have 
been repaired and retested.

In this lesson, you will learn about: On page:

How to Track Defects 106

Adding New Defects 107

Matching Defects 109

Updating Defects 111

Linking Defects to Tests 115

Creating Favorite Views 118
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How to Track Defects

When you submit a defect to a Quality Center project, it is tracked through 
these stages: New, Open, Fixed, and Closed. A defect may also be Rejected or it 
may be Reopened after it is fixed.

When you initially report the defect to the Quality Center project, it is 
assigned the status New, by default. A quality assurance or project manager 
reviews the defect and determines whether or not to consider the defect for 
repair. If the defect is refused, it is assigned the status Rejected. If the defect is 
accepted, the quality assurance or project manager determines a repair 
priority, changes its status to Open, and assigns it to a member of the 
development team. A developer repairs the defect and assigns it the status 
Fixed. You retest the application, making sure that the defect does not recur.

If the defect recurs, the quality assurance or project manager assigns it the 
status Reopened. If the defect is repaired, the quality assurance or project 
manager assigns it the status Closed.
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Adding New Defects

You can add a new defect to a Quality Center project at any stage of the 
testing process. In this exercise you will submit the defect that was detected 
while running the Cruise Booking test.

Note: In addition to adding defects directly in Quality Center, you can also 
import defect data from Microsoft Excel to your Quality Center project. To 
import from Excel, you must install the HP Quality Center Microsoft Excel 
Add-in and the HP Quality Center Connectivity Add-in. You can install the 
add-ins from the HP Quality Center Add-ins page. For more information, 
refer to the HP Quality Center Installation Guide.

To add a new defect:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log in to the project. 
For more information, see “Starting Quality Center” on page 13.

 2 Display the Defects module.

Click the Defects button on the sidebar. The Defects Grid displays defect 
data in a grid. Each row in the grid displays a separate defect record.
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 3 Open the New Defect dialog box.

Click the New Defect button. The New Defect dialog box opens.

 4 Describe the defect.

Type or select the following:

Summary: Unable to reserve a cruise from the Cruise page. 

Category: Defect

Severity: 2-Medium 

Subject: Cruises 

Description: The defect was detected in the Cruise Booking test. When you 
click the Now Accepting Reservations button, the Flight Finder page opens 
instead of the Cruise Reservation page.
108



Lesson 6 • Adding and Tracking Defects
 5 Determine the cycle in which the defect was detected.

In the Detected in Cycle box, click the browse button. The releases tree 
opens. Expand the tree. In the Service Packs releases folder, in the Service 
Pack 1 release, select the Cycle 1 - New Features cycle. 

You can see that Quality Center automatically assigns the value Service 
Pack 1 to the Detected in Release field. This is because Cycle 1 - New 
Features is part of the Service Pack 1 release.

Click OK to close the releases tree.

 6 Attach the URL address for the Mercury Tours page where the defect was 
detected.

Click the Attach URL button. The Attach Uniform Resource Locator (URL) 
dialog box opens. 

Type the URL address of the Mercury Tours page: 
http://<Quality Center server name>/mtours

Click OK. The URL is displayed above the Description box.

 7 Add the defect to the Quality Center project.

Click the Submit button. The defect is added to the Defects Grid.

 8 Close the New Defect dialog box.

Click Close.

Matching Defects

Matching defects enables you to eliminate duplicate or similar defects in 
your project. Each time you add a new defect, Quality Center stores lists of 
keywords from the Summary and Description fields. When you search for 
similar defects, keywords in these fields are matched against other defects. 
Note that keywords must be more than two characters and letter case does 
not affect your results.

In this exercise, you will match defects by comparing a selected defect with 
all other existing defects in the QualityCenter_Demo project.
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To match defects:

 1 Make sure that the Defects module is displayed.

If the Defects module is not displayed, click the Defects button on the 
sidebar. 

 2 Select Defect ID 37.

In the Defects Grid, select Defect ID 37. 

Note: If you cannot find Defect ID 37, click the Set Filter/Sort arrow and 
choose Clear Filter/Sort to clear the filter that is applied to the grid.

 3 Find similar defects.

Click the Find Similar Defects button.

The results are stored in the Similar Defects dialog box, sorted by the 
percentage of detected similarity. Note that there are no duplicate defects in 
the project for the selected defect.

Click Close to close the Similar Defects dialog box.
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Updating Defects

Tracking the repair of defects in a project requires that you periodically 
update defects. You can do so directly in the Defects Grid or in the Defect 
Details dialog box. Note that the ability to update some defect fields 
depends on your permission settings. After you have updated defects, you 
can view the current quality status of your release in the Release module.

In this exercise, you will update your defect information by changing the 
severity of a defect, assigning the defect to a cycle, and adding a comment. 
You will then see how updating defects is reflected in the Quality tab of the 
Releases module.

To update defects:

 1 Make sure that the Defects module is displayed.

If the Defects module is not displayed, click the Defects button on the 
sidebar. 
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 2 Open the Defect Details dialog box.

In the Defects Grid, select the defect you added in “Adding New Defects” on 
page 107. Click the Defect Details button. The Defect Details dialog box 
opens. 

 3 Change the severity level of the defect.

In the Severity box, select 5-Urgent.

 4 Determine the cycle in which the defect will be fixed.

In the Target Cycle box, click the browse button. The releases tree opens. 
Expand the tree. In the Service Packs releases folder, in the Service Pack 1 
release, select the Cycle 2 - Full cycle. 

You can see that Quality Center automatically assigns the value Service 
Pack 1 to the Target Release field. This is because the Cycle 2 - Full cycle is 
part of the Service Pack 1 release.

Click OK to close the releases tree.
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 5 Add a new comment to explain the change in the severity level.

Click the Add Comment button. A new section is added to the Comments 
box, displaying your user name and the current date.

Type: This defect should be fixed in the next service pack.

 6 View the Attachments.

Click Attachments in the sidebar. Note that the URL attachment is listed.

 7 View Linked Entities.

Click Linked Entities in the sidebar to view entities that have been linked to 
the defect. Linked Entities can include requirements, tests, test sets, test 
instances, runs, run steps, and other defects. There are currently no linked 
entities. You will learn how to link a defect to a test in “Linking Defects to 
Tests” on page 115.

 8 View the History.

Click History in the sidebar to view the history of changes made to the 
defect. For each change, the grid displays the date and time of the change 
and the name of the user who made the change. You can expand a change 
to view a list of fields modified during the change. For each field, the grid 
displays the old value and the new value.

 9 Close the Defect Details dialog box.

Click OK to exit the dialog box.

 10 Update defects directly in the Defects Grid.

In the Defects Grid, select defect ID 23. Click the Detected in Cycle box and 
click the browse button. In the releases tree, expand the release folder 
Service Packs and the release Service Pack 1. Select the Cycle 1 - New 
Features cycle and click OK.

Click the Target Cycle box and click the browse button. In the releases tree, 
expand the release folder Service Packs and the release Service Pack 1. Select 
the Cycle 1 - New Features cycle and click OK.

 11 Update defects 35 and 36.

Repeat step 10 for defects 35 and 36.
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 12 View the number of defects opened in Cycle 1 - New Features on the 
Quality tab.

Click the Releases button on the sidebar.

In the releases tree, expand the release folder Service Packs and the release 
Service Pack 1, and select the cycle Cycle 1 - New Features. Click the Quality 
tab.

In the Defect Opening Rate graph, you can see that four defects were 
detected in Cycle 1 - New Features. Two defects are assigned 4-Very High 
severity value. One defect is assigned 3-High, and one defect is assigned 
5-Urgent.

In the Outstanding Defects graph, you can see that you have three 
outstanding defects in Cycle 1 - New Features. 
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To view the status values selected for this graph, click the Configure 
Outstanding Defects link. The Configure Outstanding Defects dialog box 
opens. 

By default, New, Open, and Reopen are selected. Click OK to close the 
Configure Outstanding Defects dialog box.

Linking Defects to Tests

You can link a test in your test plan to a specific defect in the Defects Grid. 
This is useful, for example, when a new test is created specifically for a 
known defect. By creating linkage, you can determine if the test should be 
run based on the status of the defect. Note that you can also link the defect 
to other entities, such as requirements.

A defect can be linked directly or indirectly to an entity. When you add a 
defect link to an entity, Quality Center adds a direct link to this entity and 
indirect links to other related entities. 

The following diagram illustrates the flow of indirect linkage:
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For instance, when you link a defect to a run step, it adds an indirect link to 
its run, test instance, test set, and test. If the same test is covered by a 
requirement, an indirect link is also added to the requirement. Note that the 
indirect linkage is a one-directional flow. For example, if you link a defect to 
a run, it is not indirectly linked to its run steps.

In this exercise, you will link your defect to the Cruise Booking test in the 
Test Plan module, and view the linked test in the Defects Grid.

To link a defect to a test:

 1 Display the Test Plan module.

Click the Test Plan button on the sidebar. 

 2 Select the Cruise Booking test.

In the test plan tree, under Cruises, expand Cruise Reservation and select the 
Cruise Booking test. Click the Linked Defects tab.
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 3 Add a linked defect.

In the Linked Defects tab, click the Link Existing Defect arrow and choose 
Select. The Defects to Link dialog box opens. 

Select the defect you added in “Adding New Defects” on page 107 and click 
the Link button. Your defect is added to the Linked Defects grid.

Note: If you cannot find your defect in the Defects to Link dialog box, click 
the Set Filter/Sort arrow and choose Clear Filter/Sort to clear the filter that 
is applied to the grid.
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 4 View the linked test in the Defects Grid.

Click the Defects button on the sidebar.

Select your defect in the Defects Grid, and click the Defect Details button. 
The Defect Details dialog box opens.

Click Linked Entities in the sidebar, and select the Others tab. You can see 
that the Cruise Booking test is linked to your defect.

Click OK to close the Defect Details dialog box.

Creating Favorite Views

A favorite view is a view of a Quality Center window with the settings you 
applied to it. For example, in the Defects Grid, you may want to apply a 
filter to display only the defects that were detected by you, are assigned to 
you, or have the status “Not Closed”. 

In this exercise, you will create a favorite view in the Defects Grid.

To create a favorite view:

 1 Make sure that the Defects module is displayed.

If the Defects module is not displayed, click the Defects button on the 
sidebar. 
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 2 Define a filter to view defects you detected that are not closed.

Click the Set Filter/Sort button. The Filter dialog box opens. 

Click the Filter Condition box that corresponds to Detected By. Click the 
browse button. The Select Filter Condition dialog box opens.
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Under Name, select your Quality Center login user name (alice_qc, cecil_qc, 
or michael_qc). Click OK to close the Select Filter Condition dialog box.

For the Status field, click the Filter Condition box. Click the browse button. 
The Select Filter Condition dialog box opens.

In the right pane, click the logical expression Not.

In the left pane, select Closed.

Click OK to close the Select Filter Condition dialog box.

Click OK to apply your chosen filter.

The Defects Grid displays the defects you detected that are not closed.

 3 Add a favorite view.

In the Favorites menu, choose Add to Favorites. The Add Favorite dialog 
box opens.

In the Name box, type: My detected defects (status ‘Not Closed’).
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You can add a favorite view to either a public folder or a private folder. Views 
in the public folder are accessible to all users. Views in the private folder are 
accessible only to the person who created them. For the purpose of this 
exercise, select Private. 

Click OK. The new view is added to your private folder.

Now that you are familiar with how to add new defects, search for similar 
defects, update defects, link defects with tests, and create favorite views, you 
can proceed to Lesson 7, “Alerting on Changes.” In Lesson 7, you will learn 
how to track changes made to your requirements, tests, and defects. 
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7
Alerting on Changes

You can instruct Quality Center to create alerts automatically and send 
e-mail to notify those responsible when certain changes occur in your 
project that may impact the testing process. You can also add your own 
follow-up alerts.

To generate automatic notification alerts, your Quality Center project 
administrator must activate alert rules in Project Customization. Alert rules 
are based on associations you make in Quality Center between 
requirements, tests, and defects. When an entity in your project changes, 
Quality Center alerts any associated entities that may be impacted by the 
change. The alerts can be seen by all users. Quality Center also notifies the 
person responsible for the entity at the time of the change of any associated 
entities that may be impacted by the change.

Quality Center also enables you to add your own follow up-flag to a specific 
requirement, test, test instance, or defect to remind you to follow up on an 
issue. When the follow-up date arrives, Quality Center sends you an e-mail 
reminder.

In this lesson, you will learn about: On page:

Triggering an Alert 124

Creating Follow Up Alerts 126
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Triggering an Alert

When a requirement, test, test instance, or defect in your project changes, 
Quality Center can notify those responsible for any associated entities. You 
can associate tests with requirements (see “Creating and Viewing 
Requirements Coverage” on page 61) and defects with other Quality Center 
entities (see “Linking Defects to Tests” on page 115). In addition, you can 
create traceability links between requirements. For more information on 
creating traceability links between requirements, see the HP Quality Center 
User’s Guide.

Quality Center can generate alerts for these changes:

➤ When a requirement changes (excluding change of status), Quality Center 
adds an alert flag to its associated tests and notifies their designers by e-mail.

➤ When the status of a defect changes to “Fixed”, Quality Center adds an alert 
flag to its associated test instances and notifies their responsible testers by 
e-mail.

➤ When a test runs successfully, Quality Center adds an alert flag to its 
associated defects and notifies the users assigned to them by e-mail.

➤ When a requirement changes, Quality Center adds an alert flag to its traced 
to requirements and child requirements, and notifies their authors by 
e-mail.

In this exercise, you will trigger alerts for tests by changing the associated 
requirement. You will modify the Cruise Booking requirement and then you 
will view the flagged tests.

To trigger an alert:

 1 Display the requirements tree.

Click the Requirements button on the sidebar, and choose View > 
Requirement Details.

 2 Select the requirement that you want to change.

Under Cruise Reservation, select the Cruise Booking requirement. 
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 3 View the associated tests.

To view the tests that will be impacted by the change, click the Test 
Coverage tab. The tab displays the associated tests.

 4 Change the priority of the Cruise Booking requirement. 

Click the Details tab.

Click the Priority box to display the down arrow. Click the down arrow and 
select 5-Urgent. 

This change causes Quality Center to generate alerts for the tests associated 
with this requirement. Quality Center also notifies by e-mail the designers 
of these tests. 

 5 View the alert for the Cruise Booking test.

In the Test Coverage tab, click the Cruise Booking test. The test is 
highlighted in the test plan tree.

Click the Refresh All button.

The Cruise Booking test has an alert flag , indicating that a change was 
made to an associated requirement. 
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Click the Alerts flag for the Cruise Booking test. The Alerts dialog box opens. 

The alert indicates the requirement and the change that triggered the alert. 
It also indicates the name of the person that is notified by e-mail of this 
change. 

Click the close button.

 6 View the alerts of the other associated tests.

In the test plan tree, view the alerts of the following tests: Cruise Search, 
Cancel All Reservations, and Airline Preference.

Creating Follow Up Alerts

Quality Center enables you to add your own alerts to remind you to follow 
up on outstanding issues. In this exercise, you will add a follow-up flag to a 
defect whose status you want to check one week from today.

When you add a follow-up flag, Quality Center also adds an information bar 
that reminds you about the follow-up alert. When the follow-up date 
arrives, Quality Center sends you an e-mail reminder and changes the flag 
icon from gray to red.

Note that follow-up flags are specific to your user name, meaning that only 
you can see your follow-up alerts.

To create a follow up alert:

 1 Display the Defects module.

Click the Defects button on the sidebar.
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 2 Select the defect that you want to flag with a follow up reminder.

In the Defects Grid, select a defect.

 3 Create the follow up alert.

Click the Flag for Follow Up button. The Flag For Follow Up dialog box 
opens. 

Do the following:

Follow up by: Select the date one week from today.

Description: Type: Remind me about this defect on this date.

Click OK. The flag icon  is added to the defect record.
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 4 Display the information bar for your follow up alert.

Double-click the defect with the follow up flag. The Defect Details dialog 
box opens and displays an information bar with your follow up alert.

Click Cancel to close the dialog box.

Now that you are familiar with alerting on changes, you can proceed to 
Lesson 8, “Analyzing the Testing Process.” In Lesson 8, you will learn how to 
generate reports and graphs to help you analyze the testing process. 
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Analyzing the Testing Process

Quality Center reports and graphs help you assess your testing process. You 
can generate reports and graphs at any time during the testing process from 
the Requirements, Test Plan, Test Lab, and Defects modules, using default or 
customized settings. When customizing a report or graph, you can apply 
filters and sort conditions, and display information according to your 
specifications. You can also save your settings as favorite views and reload 
them as needed.

Note: You can also use Live Analysis Graphs, the Document Generator and 
Excel Report Generator to further analyze your Quality Center data in 
Microsoft Word or Microsoft Excel. For more information on these analysis 
tools, refer to the HP Quality Center User’s Guide.

In this lesson, you will learn about: On page:

Generating Reports 130

Generating Graphs 137
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Generating Reports

You can generate a report from the Requirements, Test Plan, Test Lab, and 
Defects modules. Each of these modules contains various report options. 
After you generate a report, you can customize report properties to display 
information according to your specifications.

In this exercise, you will generate a standard requirements report, customize 
the report for a specific user name, and add it to your favorites list.

To generate a report:

 1 Open the QualityCenter_Demo project.

If the QualityCenter_Demo project is not already open, log in to the project. 
For more information, see “Starting Quality Center” on page 13.

 2 Display the Requirements module.

Click the Requirements button on the sidebar to display the requirements 
tree.

 3 Choose a report.

Choose Analysis > Reports > Standard Requirements Report. The report 
opens, displaying default data. 
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 4 Display the customization options.

Click the Configure Report and Sub-Reports button. The Report 
Customization page opens with the default options selected.

 5 Set the number of items per display page.

Under Page, select All items in one page to display all items in one page.
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 6 Define a filter to view requirements created by a specific user name.

Under Filter, click the Set Filter/Sort button. The Filter dialog box opens. 
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For the Author field, click the Filter Condition box. Click the browse button. 
The Select Filter Condition dialog box opens.

Under Name, select your Quality Center login user name (alice_qc, cecil_qc, 
or michael_qc). Click OK to close the Select Filter Condition dialog box.

Click OK to close the Filter dialog box.
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 7 Specify the fields and the order in which they are displayed. 

Under Fields, select Custom Fields (layout) and click the Select Fields 
button. The Select Fields dialog box opens. 

The Available Fields box lists fields that are not currently displayed. The 
Visible Fields box lists fields that are currently displayed.

In the Visible Fields box, select Creation Time and click the left arrow button 
to move the field to Available Fields. Move Modified to Available Fields.
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To set the appearance order of the visible fields, select ReqID and use the up 
arrow button to move the field under Author. Move Name and Description 
so that they appear below ReqID.

Tip: You can also use a drag-and-drop operation to specify visible fields and 
the order in which they are displayed.

Click OK to close the dialog box and apply the new field order.

 8 Clear the Attachments and History options.

Under Fields, clear the Attachments and History check boxes.
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 9 Generate a new report.

Click the Apply button. The customized Requirements Report is displayed. 

 10 Add the report as a favorite view.

Click the Add to Favorites button. The Add Favorite dialog box opens.

In the Name box, type: Standard Requirements by Author. Click OK. The 
report is added to the Reports list in the left pane.

 11 Close the report.

Click the Close button. The Requirements module is displayed.

Tip: You can create a quick report for specific nodes in a tree, or rows in a 
grid by selecting the requirements, tests, or defects, and choosing Analysis > 
Report Selected. You can select multiple nodes or rows by pressing the CTRL 
key.
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Generating Graphs

Quality Center graphs help you analyze the relationships between different 
types of data in a project. Each Quality Center module contains various 
graph options. After you generate a graph, you can customize graph 
properties to display information according to your specifications. 

In this exercise, you will generate a defects graph to summarize the defects 
by status and priority level.

To generate a graph:

 1 Display the Defects module.

Click the Defects button on the sidebar. The Defects module displays the 
Defects Grid.

Click the Set Filter/Sort arrow and choose Clear Filter/Sort to clear the filter 
that is applied to the Defects Grid.
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 2 Choose a graph.

Choose Analysis > Graphs > Summary - Group by ‘Status’. The Defects - 
Summary Graph opens. By default, the graph is grouped by Status.
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 3 Open the Filter dialog box.

Click the Filter button. The Filter dialog box opens. 
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 4 Define a filter to view defects with high to urgent priority.

In the Filter dialog box, for the Priority field, click the Filter Condition box. 
Click the browse button. The Select Filter Condition dialog box opens.

In the right pane, select the logical expression >=.

In the left pane, select 3-High.

Click OK to close the Select Filter Condition dialog box.

 5 Define a filter to view defects that are not closed.

For the Status field, click the Filter Condition box. Click the browse button. 
The Select Filter Condition dialog box opens.

In the right pane, select the logical expression Not.

In the left pane, select Closed. 

Click OK to close the Select Filter Condition dialog box.

Click OK to close the Filter dialog box.
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 6 Set the X-axis of the graph.

From the X-Axis list on the right side of the window, select Priority to view 
the number of defects by priority.

 7 Refresh the graph.

Click the Refresh button. A new graph is displayed. 

In this exercise, nine defects are assigned 3-High; eight defects are assigned
4-Very High; and one defect is assigned 5-Urgent.
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 8 Display additional defect details.

Click a bar segment in the graph. The Drill Down Results dialog box opens 
and displays the defects that belong to the bar segment. 

Close the Drill Down Results dialog box.

 9 Display other graph views.

Click the Pie Chart tab to display the graph as a pie chart.

Click the Data Grid tab to display the data as a grid.

 10 Close the graph.

Click the Close button. The Defects module is displayed.

Now that you are familiar with generating reports and graphs, you can 
proceed to Lesson 9, “Customizing Projects.” In Lesson 9, you will learn 
how to customize a project by adding and defining a project user. You will 
also learn how to add a user-defined field and create a project list. 
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Customizing Projects

In the previous lessons, you learned how to use Quality Center to help you 
manage all phases of the application testing process, including specifying 
releases and cycles, specifying testing requirements, planning tests, running 
tests, and tracking defects.

In this lesson, you will learn how to customize your Quality Center project 
to meet the needs of your testing team. You can control access to a project 
by defining the users who can access the project and by specifying the types 
of tasks each user can perform. Suppose new members are added to your 
testing team. You assign them to the projects that they will be testing, and 
specify the tasks that they can perform. 

You can also customize your Quality Center project by modifying its system 
fields or by adding user-defined fields. Fields can be associated with system 
and user-defined lists. A list contains the values that the user can enter in a 
field. For example, if you are running tests on several builds of an 
application, you can add a Detected in Build field to the Defects module. 
You can then create a selection list containing the values Build1, Build2, and 
Build3, and associate the list with the Detected in Build field.

In this lesson, you will learn about: On page:

Starting Project Customization 144

Adding a New Project User 147

Assigning a User to a User Group 151

Defining a User-Defined Field 153

Creating a Project List 156
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Starting Project Customization

You customize your Quality Center projects using the Project Customization 
window. In this exercise, you will log in to the Project Customization 
window with project administrator privileges.

To start project customization:

 1 Open the HP Quality Center Login window.

Make sure that the HP Quality Center Login window is open. For more 
information, see “Starting Quality Center” on page 13.

 2 Type a user name with project administrator privileges and authenticate.

In the Login Name box, type alex_qc.

Skip the Password box. A password was not assigned to this user name.

Click the Authenticate button. Quality Center verifies your user name and 
password and determines which domains and projects you can access. 

 3 Log in to the project.

In the Domain list, select Default.

In the Project list, select QualityCenter_Demo. 

Click the Login button.

The Quality Center main window opens and displays the module in which 
you were last working.
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 4 Open the Project Customization window.

Choose Tools > Customize on the upper-right corner of the Quality Center 
window. The Project Customization window opens.

By default, the Project Customization window contains the following links:

Option Description

User Properties Enables you to change your user properties. For 
example, you can change your e-mail address. You can 
also change your password.

Project Users Enables you to add and remove users from a 
Quality Center project. You can also assign users to 
user groups to restrict user access privileges.

Groups Enables you to assign privileges to user groups by 
specifying permission settings.

Module Access Enables you to control the modules that each user 
group can access. By preventing users from accessing 
unnecessary modules, you can better utilize your 
Quality Center licenses.
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In the procedures below, you will use these options: Project Users, Project 
Entities, and Project Lists. For more information on all of the above options, 
refer to the HP Quality Center Administrator’s Guide.

Project Entities Enables you to modify the behavior of Quality Center 
system fields or define user-defined fields that are 
unique to your project. For example, if you are 
running tests on several builds of an application, you 
can add a Detected in Build user-defined field to the 
New Defect dialog box. You can then associate it with 
a selection list containing the values for this field.

Requirement Types Enables you to customize the definitions for 
requirement types.

Risk-Based Quality 
Management

Enables you to customize settings for risk-based 
quality management.

Project Lists Enables you to add customized lists to a project. A list 
contains values that the user can enter in system or 
user-defined fields. For example, for the Detected in 
Build field, you can create a selection list containing 
the values Build1, Build2, and Build3.

Automail Enables you to set up automatic mail notification rules 
to inform users via e-mail each time changes are made 
to specified defects.

Alert Rules Enables you to activate alert rules for your project. This 
instructs Quality Center to create alerts and send 
e-mails when changes occur in the project.

Workflow Enables you to generate scripts to perform commonly 
needed customizations on the fields of the Defects 
module dialog boxes. In addition, you can write scripts 
to customize dialog boxes in any module, and to 
control the actions that users can perform.

Option Description
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Adding a New Project User

You can control access to a Quality Center project by defining the users who 
can log in to the project, and by specifying the types of tasks each user may 
perform.

For each project, you select project users from the Quality Center site users 
list. This list is created in Site Administration.

From Project Customization, you add users to a project and assign them to 
user groups. Each user group has access to certain Quality Center tasks. 

In this exercise, you will add a new project user to the QualityCenter_Demo 
project.

To add a new project user:

 1 Make sure that you are logged in to Quality Center as a project 
administrator.

For more information on how to open the Project Customization window, 
see “Starting Project Customization” on page 144.
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 2 Open the Project Users page.

In the Project Customization window, click the Project Users link. The 
Project Users page opens and displays a list of users that have been assigned 
to the project.
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 3 Add a new user name.

Click the Add User button. The Add User to Project dialog box opens.

This dialog box enables you to add an existing user from the list of site users 
by typing the user’s name or by selecting the user from the list of site users. 
You can also create a new user and add the new user to the project. In this 
exercise, you will add an existing user by typing the user’s name.

Make sure that Add user by user name is selected. In the Add user by user 
name box, type tom_qc and click OK.
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The new user is added to the Project Users list and the user properties are 
displayed in the Personal Settings area. User personal settings are defined in 
Site Administration.
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Assigning a User to a User Group

To enable users to do their job, and to protect a project from unauthorized 
access, Quality Center enables you to assign each user to a specific user 
group. Each group has access to certain Quality Center tasks. You can use 
the predefined user groups with their default permissions or you can 
customize your own user groups with unique sets of permissions. 

The following table describes the predefined Quality Center user groups and 
their default permissions:

In this exercise, you will assign the new user to the QATester user group.

User Group Permissions

TDAdmin 
(Project 
Administrator)

Group members have full privileges in a Quality Center project 
and in Project Customization.

Project 
Manager

Group members have full privileges in the following 
Quality Center modules: Releases, Requirements, Test Plan, Test 
Lab, and Defects. In Project Customization, the group has 
privileges to change user properties and password, customize 
project lists, and set alert rules.

QATester Group members have full privileges in the following 
Quality Center modules: Releases, Requirements, Test Plan, and 
Test Lab. In the Defects module, the group can add and modify 
defects and defect links. In Project Customization, the group 
has privileges to change user properties and password, 
customize project lists, and set alert rules.

Developer Group members are limited to modifying attachments or record 
details in the following Quality Center modules: Requirements, 
Test Plan, and Test Lab. In the Releases module, group members 
have full permissions. In the Defects module, the group can add 
and modify defects, and add defect links. In Project 
Customization, the group has privileges to change user 
properties and password.

Viewer Group members have read-only privileges in a Quality Center 
project, and no privileges in Project Customization.
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To assign a user to a user group:

 1 Make sure that the Project Users page is displayed.

If the Project Users page is not already open, click the Project Users link in 
the Project Customization window.

 2 Select tom_qc from the Project Users list.

In the Project Users list, select tom_qc. The user properties are displayed. By 
default, a new user is assigned to the Viewer user group.

 3 Assign tom_qc to the QATester group.

Under Not Member Of, select QATester and click the left arrow button to 
move it to Member Of.
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 4 Remove tom_qc from the Viewer group.

Under Member Of, select Viewer and click the right arrow button to move it 
to Not Member Of.

Click Save to save the changes to the Project Users page. Click OK.

Defining a User-Defined Field

You can customize your Quality Center project to suit your testing needs. 
You can modify the behavior of Quality Center system fields or define 
user-defined fields that are unique to your project.

The fields are stored in Quality Center project entities. For example, the 
Defect entity contains data entered in the Defects module.

In the following exercise, you will add the Database user-defined field to the 
Defect entity. This field indicates the server database in use when testing an 
application.

To add a user-defined field:

 1 Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, 
see “Starting Project Customization” on page 144.
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 2 Open the Project Entities page.

In the Project Customization window, click the Project Entities link. The 
Project Entities page opens.

The following project entities are available:

Entity Description

Cycle Cycle data in the Releases module.

Defect Defect data in the Defects module.

Release Release data in the Releases module.

Release Folder Release folder data in the Releases module.

Requirement Requirement data in the Requirements module.

Run Test run data in the Test Lab module.

Test Test data in the Test Plan module.

Test Instance Test instance data in the Test Lab module.
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 3 Add a new user-defined field to the Defect entity.

Under Project Entities, expand Defect. 

Click the User Fields folder and click the New Field button. A new field is 
added under the User Fields folder.

BG_USER_XX indicates a user-defined field under the Defect entity.

 4 Rename the default field name.

In the Field Label box, instead of the default name, type Database. This new 
field name will be displayed in Quality Center.

Click Save.

Click OK.

Test Set Test set data in the Test Lab module.

Test Step Design step data in the Test Plan module, and test step 
data in the Test Lab module.

Entity Description
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Creating a Project List

You can associate fields with system and user-defined lists. A list contains 
values that the user can enter in a field. 

In the previous exercise you added the Database field. In the following 
exercise you will create a list and assign it to the Database field. You will 
then open the New Defect dialog box to view the new field.

To create a project list:

 1 Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, 
see “Starting Project Customization” on page 144.

 2 Open the Project Lists page.

In the Project Customization window, click the Project Lists link. The 
Project Lists page opens.
156



Lesson 9 • Customizing Projects
 3 Create a new list.

Click New List. The New List dialog box opens.

In the List Name box, type DB. Click OK to close the New List dialog box.

 4 Add Items to your list.

Click New Item. The New Item dialog box opens. Type Oracle and click OK.

Repeat the same procedure and add MS SQL and MSDE to the DB list.

Click Save to save the changes to the Project Lists page. Click OK.
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 5 Assign the list to the Database field.

In the Project Customization window, click the Project Entities link. The 
Project Entities page opens.

Under Project Entities, expand Defect.

Expand the User Fields folder and select Database.

Under Field Settings, in the Field Type list, select Lookup List to set the field 
type as a drop-down list. The Lookup List section is displayed under the 
Field Settings section.

Under Lookup List, select the DB list. 

Click Save to save the changes to the Project Entities page. Click OK.
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 6 View the new user-defined field in the New Defect dialog box.

Click the Return button located on the upper-right corner of the window to 
exit the Project Customization window and return to your Quality Center 
project.

In the Defects module, click the New Defect button. The New Defect dialog 
box opens. 

The Database field is displayed in the New Defect dialog box. Click the 
down arrow and see the database types you defined. Click Close.

Now that you are familiar with how to customize a project, you can proceed 
to Lesson 10, “Where Do You Go from Here?” In Lesson 10, you will apply 
the Quality Center concepts and skills you learned to your own application.

New user-defined 
field
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10
Where Do You Go from Here?

Now that you have completed the tutorial, you are ready to apply the 
Quality Center concepts and skills you learned to your own application. You 
also need to know where to access additional information.

Getting Started

Test management with Quality Center includes five phases: specifying 
releases, specifying requirements, planning tests, running tests, and tracking 
defects. Throughout each phase, you can analyze data by generating 
detailed reports and graphs.

To get started:

 1 Specify your release plan and define cycles for your releases.

To specify your release plan, consider these steps:

➤ Decide how to break up your application releases.

➤ For each release, determine how to break it down into cycles.

➤ Analyze the progress and quality of your releases and cycles.

In this lesson, you will learn about: On page:

Getting Started 161

Documentation Library 164

Additional Online Resources 166
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 2 Analyze your application and determine your requirements.

To specify your requirements, consider these steps:

➤ Examine the application documentation to determine your testing 
scope—test goals, objectives, and strategies.

➤ Build a requirements tree to define your overall requirements. After you 
have created tests, you can use them to cover your requirements. In this 
way, you can keep track of your testing needs at all stages of the testing 
process.

➤ For each requirement topic in the requirements tree, create a list of 
detailed requirements. Describe each requirement, assign it a priority 
level, assign it to releases and cycles, and add attachments if necessary.

➤ Generate reports and graphs to assist you in analyzing your 
requirements. Review your requirements to ensure they meet your 
testing scope.

 3 Create a test plan, based on your requirements.

To create a test plan, consider these steps:

➤ Examine your application, system environment, and testing resources to 
determine your testing goals.

➤ Divide your application into modules or functions to be tested. Build a 
test plan tree to hierarchically divide your application into testing units, 
or subjects.

➤ Determine the types of tests you need for each module. Add a basic 
definition of each test to the test plan tree.

➤ Link each test to requirements.

➤ Develop manual tests by adding steps to the tests in your test plan tree. 
Test steps describe the test operations and the expected outcome of each 
test. Decide which tests to automate. Afterwards, you can link tests to 
defects.

➤ Create test scripts for tests that you want to automate. You can automate 
tests using HP testing tools, custom testing tools, or third-party testing 
tools.

➤ Generate reports and graphs to assist in analyzing test planning data. 
Review your tests to determine their suitability to your testing goals.
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 4 Create test sets and perform test runs.

To create test sets and run tests, consider these steps:

➤ Define test set folders and test sets to meet the various testing goals in 
your project. Assign each test set folder to a cycle. Decide which test sets 
to include in each test set folder, and which tests to include in each test 
set.

➤ Schedule test runs and assign tasks to application testers. 

➤ Run the tests in your test sets automatically or manually.

➤ View the results of your test runs to determine whether a defect was 
detected in your application. Generate reports and graphs to help analyze 
these results.

 5 Submit defects detected in your application and track the progress of 
defect fixes.

To submit and track defects, consider these steps:

➤ Submit new defects detected in your application. 

➤ Add a link between defects and the following entities: requirements, 
tests, test sets, test instances, runs, run steps, and other defects.

➤ Review new defects and determine which ones should be fixed.

➤ Correct the defects that you decide to fix.

➤ Test a new build of your application. Repeat this process until defects are 
fixed.

➤ Generate reports and graphs to assist in analyzing the progress of defect 
fixes and to help determine when to release the application.
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Documentation Library

The Documentation Library is an online help system that describes how to 
use Quality Center. You can access the Documentation Library in the 
following ways:

➤ Click Documentation Library in the Quality Center Help menu to open 
the Documentation Library home page. The home page provides quick 
links to the main help topics.

➤ Click Help on this page in the Quality Center Help menu to open the 
Documentation Library to the topic that describes the current page.

 

Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest versions of 
Quality Center. (Available online and in PDF format.)

You can also access What’s New? from the Quality Center Help menu. In 
addition, you can choose Help > Product Feature Movies to view short 
movies that demonstrate the main product features. 

Readme provides last-minute news and information about Quality Center. 

Quality Center Guides:

HP Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects. (Available 
online and in PDF format.)

HP Quality Center Administrator’s Guide explains how to create and 
maintain projects using Site Administration, and how to customize projects 
using Project Customization. (Available online and in PDF format.)
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HP Quality Center Tutorial is a self-paced guide teaching you how to use 
Quality Center to manage the software testing process. (Available in PDF 
format.)

HP Quality Center Installation Guide explains how to install Quality Center 
on a server machine in a cluster environment or as a stand-alone 
application. (Available in PDF format.)

Business Process Testing Guides:

HP Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)

HP Business Process Testing Tutorial provides a self-paced guide that teaches 
you the basics of Business Process Testing in the Quality Center application. 
(Available in PDF format.)

API References:

HP Quality Center Database Reference provides a complete online reference 
for the project database tables and fields. (Available online.)

HP Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)

HP Quality Center Site Administration API Reference provides a complete 
online reference for the Site Administration COM-based API. You can use 
the Site Administration API to enable your application to organize, manage, 
and maintain Quality Center users, projects, domains, connections, and site 
configuration parameters. (Available online.)

HP Quality Center Custom Test Type Guide provides a complete online 
guide for creating your own testing tool and integrating it into the Quality 
Center environment. (Available online.)
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Additional Online Resources

The following additional online resources are available from the 
Quality Center Help menu:

Knowledge Base uses your default Web browser to open the Mercury 
Customer Support Web Site directly to the Knowledge Base landing page.

Customer Support Web Site uses your default Web browser to open the 
Mercury Customer Support Web site. This site enables you to browse the 
Mercury Support Knowledge Base and add your own articles. You can also 
post to and search user discussion forums, submit support requests, 
download patches and updated documentation, and more. The URL for this 
Web site is http://support.mercury.com. 

HP Software Web site uses your default Web browser to access the HP 
Software Web site. This site provides you with the most up-to-date 
information on HP Software products. This includes new software releases, 
seminars and trade shows, customer support, and more. The URL for this 
Web site is http://www.hp.com/managementsoftware. 

Add-ins Page opens the HP Quality Center Add-ins Page, which offers 
integrations with HP testing tools, as well as third-party, synchronization, 
and version control tools. For more information, refer to the 
HP Quality Center Installation Guide.
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